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This manual is intended to be a user's guide on how to set up and run FRAME. Its
purpose is not to discuss in detail the methodology of this approach. For a more detailed
discussion, the reader is referred to McGinnis, Beamon, and Fang [1992].

1. Introduction
FRAME is a software platform to model, analyze and appraise the reliability of monorailbased interbav material handling systems widely employed in semiconductor fabrication facilities.

The purpose of FRAME is to facilitate the reliability assessment of such material handling
systems and thus to enable the designer to incorporate reliability analysis into the design of
semiconductor fabs.

The components of FRAME consist of a high performance personal computer, a printer,
and a collections of commercial software to implementation the tools. The opEnating environment
is based on AutoCAD,., a computer aided drafting package, which is used as the hub of
modeling.

1.1 Basic Approach of FRAME
We assume a fixed rate at which requests for transport are generated. Each transport
request corresponds to the movement of lot box by a car from one stocker to another. The entire
transport rates can be described in a from/to matrix, which is referred to as transport requirement
matrix. Accordingly, each entry in the matrix is a transport requirement.

Since cars may travel without a lot box (if none are awaiting transport where a delivery
was just made), and failures may occur to unloaded cars, it is necessary to estimate the
unloaded car travel. A trip is defined as the process of a car traveling (either loaded or unloaded)
from one stocker to another. A dispatching rule is used to estimate the travel associated with
unloaded cars, assuming a given transport requirement matrix. These unloaded travel rates are
also described as a from/to matrix.
When a particular transport request (defined by an originating bay and a destination bay)
is assigned to a particular car, the result is a transport task. Notice that a transport task will
usually include some unloaded car travel to the originating bay.
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The focus of this analysis approach is on both trips and transport tasks. Notice that a
transport task failure is generally not the same as one component failure. Take the material
control system (MCS) for example. One MCS failure is equivalent to N transport

~ask

failures

where N is the average number of transport tasks in progress at any time. The core of FRAME is
an analytical algorithm to estimate failed trips and failed transport tasks for one time period.
Based on these estimates, the component types as well as the individual components that are
most apt to cause transport task failures can be identified. We will explain the implications of the
output of FRAME later in this chapter.

Premises of this approach are the following general assumptions which should be
realistic for a practical material handling system in operation:

(a) All components are operating in the steady-state periods of their lifetime with regard
to reliability. In other words, all components have constant failure

r~tes

or equivalently, mean

time bet_ween failures (MTBF).

· (b) All the components involved in each individual trip operate in series with regard to the
trip. To put it another way, the failure of any one of these transactions will result in the failure of
the entire trip.

(c) All the components in the material handling system operate independent of each
other, including the transport cars. This is for the purpose of decoupling the evaluation of the
frequency of failure incidents from the evaluation of the impact that failures have on production
system performance.

Figure 1.1 briefly shows the structure of FRAME. In the next two sections we will
discuss the user input and then the implications of analysis results.

1.2 Information Required for Analysis

As shown in Figure 1.1, the user input into FRAME includes 1) the material handling
system layout and related parameters (transport requirement for one shift, transport car speed,
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track segment speed factor, etc.), and 2) MTBFs of the components. For input of 1), the user
needs to create the layout of the material handling system, and specify the necessary operating
parameters. The data required in 2), however, are usually not readily available in reality, and a
certain conversion process called normalization has to be carried out in order to

~get

the desired

data before the reliability analysis can be performed. In the following we illustrate the notions of
conversion and normalization through examples. It is very important to emphasi:ze here that we
define mean time as the mean operating time as opposed to mean uptime in E1 0-90. Our MTBF
is equivalent to mean cycles between failure (MCBF).

---+

users ineuts/modifies:
1) MHS ayOut and related
parameters; 2) Component '
reliability data.

~

+
FRAME verifies input validity,
generates relevant internal
files, and computes reliability
measures.

~

J.,
FRAME displays results
of analysis

Figure 1.1 Structure of FRAME
Let us assume that the transport car has a loaded traveling speed of v1 feet per minute,
and an unloaded traveling speed of v" feet per minute. We further assume that the total loaded
and unloaded car travel per time period are

s1 and s" respectively.

By observation we have

found that the average car failures occurred per time period is ~. Then the mean time between
failure (MTBF) of the transport car can be calculated by
MTBF

=(s1 1v1 +SuI Vu )/ 60

(hours)

Fe ·
Procedures are similar for other modules. Assume the total number of transactions per
time period performed by a module is C. From observation the module is found to have an
average of Fm failures per time period. Then the mean cycles (transactions) between failure is
given by
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MCBF =..£_

Fm
Since for one transaction the module needs to operate t seconds, we get the mean time
between failure (MTBF) of this module as follows:
MTBF

=MCBFx-L=
3600

Cxt

(hours)

Fm X 3600

Example Consider the cycle data for the AS/RS units collected over some time periods as
follows:

Num of c cles

Num of failures

Num of assists

MCBF

MCBF&A

322,810

42

459

7686

703

If we know the average operating time for one AS/RS cycle is 20 seconds, then the
MTBF and MTBF&A can be readily computed from the above MCBF and MCBF&A respectively:
MTBF =_]JJ_-xMCBF =42.7 (hours)
3600
MTBF &A= _lJ)__x MCBF &A= 3.9 (hours)
3600

1.3 Explanation of Analysis Results

Analysis results generated by FRAME include the following:

• Loaded and unloaded trip unavailability

These quantities measure the inherent reliability of the loaded and unloaded trips. By
inherent we mean the measure is decoupled from the effect of different transport requirement.
The trips with the highest unavailabilities should be avoided as much as possible~ since they tend
to be unreliable during operation.

• Expected number of trip failures
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These quantities measure the reliability of the trips under the given flow. They are the
expected number of failures for each trip per unit time. The trips that have the highest numbers
tend to have high trip unavailability and/or heavy lot flow.

• Expected number of transport task failures

These quantities measure the reliability of the material handling system under the given
flow as well as the empty vehicle dispatching rule. Due to the fact these are ~ composite
measures of system reliability, they tend to be of greater importance to system designer and
operator. Also worth pointing out is that the sum of all these entries measures the overall
reliability of the material handling system.

• Most critical components/modules

These are the components/modules that cause the most transport task failures in the
system. These components either are inherently unreliable (low MTBF) or have heavy work
loads or both. They provide insightful clues for system reliability enhancement..

• Contribution to transport task failures by each component t~e

This is a list of the amount of contribution to transport task failures in decreasing order by
all component types. This information is useful in identifying which of the different component
types are causing the most problems and thus also provide also sheds light in system reliability
improvement.
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2. Installation Guidelines

2.1 Hardware Requirements for EWS
The hardware requirements for the Engineering Work Station, EWS, are dictated by
AutoCADTMVersion 10.0 that runs on a personal computer. If you already havE~ (or are able to
get) AutoCADTM Version 10.0 on your computer, you may proceed to install the additional
software that will help you analyze Automated Electrified Monorail Systems. Refer to the
AutoCADTM Installation and Performance Guide for the version number.
**If you do not have AutoCADTM Version 10.0, STOP. You cannot install the EWS! **

2.2 Installing AutoCADTM Version 10.0
Before installing the EWS software, pleaf~e install AutoCADTM Version 10.0 on a directory
named by your preference. The installation procedure for AutoCADTM Version 10.0 is described in
the AutoCADTM Installation and Performance Guide, and will not be repeated here.
NOTE: If you do not already have it, please put the following line in your AUTOEXEC.BAT file:

PROMPT $P$G
The operating system will display the current subdirectory name on the DOS prompt line.

2.3 Modifying AutoCADTII Version 10.0 for Use with the EWS
Suppose AutoCADTM Version 10.0 has been installed in a directory called ACAD. Once it
has been installed on your system•s hard disk, AutoCADTM will need to be configured for your
hardware system. The general configuration procedure is described in Appendix D of the
AutoCADTM Reference Guide. To perform the general configuration, do the following (What you
need to type in is underlined):
1 . Change the directory to ACAD by typing
C:\ > CD\ACAD
2. Invoke the AutoCADTM program by typing
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C:\ACAD > ACAO
and you will be presented with the AutoCADn.c Main Menu.
3. Choose selection 5, "Configure AutoCAD", and you will then be presented with the current
configuration. Press the Enter key. Next, the Configuration Menu will be displayed. For the
general configuration, you need only to configure the video display, the digitizer, the plotter,
and the printer (selections 3, 4, 5, and 6 on the Configuration Menu).
4. Choose selection 3, "Configure video display". Note that AutoCADn.c can

bE~

configured in

either single-screen or dual screen modes. The dual screen mode requires an additional
monitor attached to your computer. The EWS will work with boHl single- and dual-screen
modes. If single-screen mode is desired, simply configure AutoCADn. for the video board
contained in your computer. If dual-screen mode is desired, configure Aute>CADn.c for the
video board which will drive the graphics screen. AutoCADn.c in dual-screen mode will make
-- the necessary adjustment. You will need to make a few changes to the EWS-specific file
START .BAT in order to use the EWS in dual-screen mode. Additional directions will be
provided once the EWS is installed.
NOTE: We have experienced some problems using the dual-screen mode with IBM PS/2
M80, for which we suggest the single-screen mode. Dual screen mode works better
with AT -style motherboards.
After identifying the video board in your computer, you will be presented with a number of
prompts. You should choose the default settings in response to all prompts except the
following:
Do you want a status line? <N> Y
Do you want a command prompt area? <Y> N
Do you want a screen menu area? <Y> N
Do you want dark vectors on a light background? <N> Y
5. Configure your digitizer (or mouse) following the directions on the configuration submenu.
6. If you have a printer and/or plotter that will work with AutoCADn.c, configure your hardware
according to the directions on the configuration submenu. The EWS does not need a printer
nor a plotter to function, although both are desirable.
7. When finished with configuring your hardware, choose selection 8, "Configure operating
parameters", from the Configuration Menu. The Operating parameters menu will be
displayed.
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8. Choose option 2, .. Initial drawing setup•, and specify the default prototype drawing by typing
Enter name of defauft ..... <.>:PROTOTYP
9. Choose option 7, •AutoLISP feature .. , from the Operating parameters menu and make sure
that AutoLISP is enabled by typing
Do you want AutoLISP enabled? <N> 'f..
10. You are finished with the modification of AutoCADTM. Choose selection 0 for the next two
times to get out of the submenus. Accept the current configuration by pressing ENTER or by
typing
Keep configuration changes? <Y>
and, exit AutoCADTM by selecting

'f..

o from the main menu.

If all is well up to this point, you are ready to install the EWS. If not, try the hardware
configuration again, and refer to AutoCADTM documentation. Good luck! ..

2.4 Installing the EWS

To install the EWS software, simply put the source disk into drive A or 8 and then type
''A: INSTALL• or

·a: INSTALL• respectively under DOS prompt.

Then follow the instructions

shown on the screen. When installation finished, it prompts ••Installation Completed". It should
automatically create the directory you specified and another subdirectory called EXE under the
specified directory.
Suppose the directory you specified is called SEMATECH under the root directory.
Under directory SEMATECH, a batch file, START.BAT, comes initially configured for either the
single-screen or the dual-screen system. Without going through the installation procedure, you
can switch from single-screen to dual-screen mode and vice versus by simply modifying
START.BAT file. To switch to the single-screen mode, edit START.BAT with a text editor, and
put "REM • in front of "MODE MONo• command. For the dual-screen mode, simply remove
"REM • from the beginning of •MoDE MONO".
NOTE: The AutoCAD™ related environment variables are identified in START.BAT by SET
XXX=XXX type statements. The settings in START.BAT are for typical systems. You may
get better performance from your hardware configuration if you have extra memory
(extended and expanded memory). Refer to AutoCAD™ Installation and Performance
Guide.
As with any software package, you should put the original diskettes away for safekeeping.
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NOTE: For a brief description of the EWS files and programs, see Appendix G.
To test if the AutoCADN configuration will work with the EWS, type
C:\SEMATECH > \ACAD\ACAD
and invoke the AutoCADN program. From the main menu, choose selection 1 , "Begin a NEW
drawing•, and supply any name for the drawing. If the hardware is configured correctly, the
AutoCADN drawi~g screen will be displayed; a light gray background with a navy blue top line. If
so, check if your mouse is operational by moving it around. If the crosshair is moving, you are
most likely ready for a walkthrough. Exit from the drawing by typing QUIT (you may not actually
see what you typed) and then Y. Then, exit from AutoCADN by choosing selection 0, "Exit
AutoCAD•, from the Main Menu. If all is well, congratulations!.. If not, try the hardware
configuration again, and refer to AutoCADN documentation. Good luck! ..
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3. Getting Started
You are now ready for a hands-on session with the EWS. The demonstration project file,
called DEM0_1, will be used for the walkthrough. Suppose the AEMS is installed under the ·
directory named SEMATECH. In order to begin a work session, type
C:\> CD\SEMATECH

and then type
C:\SEMATECH> START

The copyright notice and the MHRC logo will be displayed. If you are using a dual-screen
system, the PROFILE program will appear on the other display screen. The· PROFILE program
will prompt the user for the project file which will be active during the current work session.
Pressing the F3 key will list the project filenames in the directory. Type
===>DEMO 1

to view the project profile, DEM0_1. The PROFILE screen is a specialized spreadsheet where
you may move between the fields by using the cursor keys on the keyboard. Any non-blank
entry on the command line will replace the value of the current field. The purpose of this file is to
insure consistency in the length and time units, the planning period (shift length) and the DOS
filenames used for the neutral database of this project. You may change the name of the DOS
files, although the extensions are standard and cannot be changed. Whenever necessary,
supply the filenames without any extension. If you wish, you may experiment on this screen by
moving to a field and entering a new value.

NOTE: For a new project, the user needs to press the F1 key to save the project profile. The
user will be prompted for the limits of the new drawing (lower-left and upper-rinht coordinates),
and the drawing screen will be set up with the specified absolute coordinates and some default
drawing parameters. Then, when in AutoCAD™, a dialog box will be displayed that gives the user
the opportunity to change the default drawing parameters.
In our case, since DEM0_1 project exists, press the F4 key to return to the main menu in
profile. Press the F4 key once again to start project DEM0_1. The drawing file, DEM0_1.DWG,
will be displayed on the graphics screen. This is the guidepath network for project DEM0_1.
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3.1 Drawing Creation and Editing
The EWS's pull-down menus are located on the top line of the screen. Move the crosshair to the top line. The menu selection names will appear. These pull-down menus contain
several convenient features to help you draw and edit the guidepath network. All of the EWS
commands are explained in greater detail in Chapter 5.
The File pull-down menu is used for file manipulation and printing activities. At any time
during the session, you may use the Abandon command to leave the EWS without making any
permanent changes to the drawing. The changes to the drawing are not made permanent until
Save or Close is selected. The changes to the neutral database will not take effect until the
Update Files command in menu Elements, Analysis or Dialog is selected.
The Layout menu is used for building the guidepath layout and specifying modules
including turntables, turnouts, transfers, and stocl<ers. Now, move the cursor to the top line to
activate the menu line, highlight word Layout, and press and release the left button. The Layout
main m~nu are displayed. They are Insert Blocks W/ Split and Insert Blocks W/0 Split. The
difference between them is if a split is performed after a block being inserted. The details is
· explained in chapter 5. Select Insert Blocks W/0 Split, then the Layout submenu is displayed.
Move the cross-hair to Straight Segment command and click on the left mouse button.
The menus on the top line of the screen will be replaced by the command prompt on the left side
(the command prompts are always enclosed within ·=>· and ·<=·).and the global coordinates
of the cross-hair position on the right side. Go ahead and supply the endpoints of the segment
which you wish to insert. After the end points of the segment are specified, a pop-up box will ask
you to supply a segment name. Place the cross-hair inside the box and type in a segment name.
Only the first 8 characters will be saved in the neutral database, although you may be able to see
more characters on the screen. Pressing Enter will end the data entry into this field. Now, you
must move the arrow in one of the small boxes; OK to accept the data in the box, Cancel to
retain the old value. Then, the pop-up menu will go away, and the guidepath segment is drawn
between the specified endpoints. This command will repeat automatically. If you wish, you may
try to enter a few more straight segments. To get out of an automatically repeating command,
press the right button on the mouse, or select Cancel command from the Edit menu, or enter a

"C (Ctrl key pressed simultaneously with letter C) from the l<eyboard.
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Now, select Curved Segment from the Layout menu. Supply the beginning point of the
curved segment with the cross-hair and enter the value of the radius from the keyboard. Then,
an icon menu is presented for you to select the orientation of the curved segment. Move the
arrow into the small box on the left of each icon to make the selection. A pop-up box will then
appear which allows you to specify a segment name for the new segment. Then, the curved
segment is drawn.
Now, move the cross-hair to the top line and select the Sketch menu. The Sketch menu
contains utilities for drawing background and other ancillary items. The drawing elements
created by the Sketch menu are for aesthetic purposes only. The user may wish to experiment
with the drawing features in this menu. The text and the boxes on the drawing (all in black) are
created by the commands in this menu.
The Edit menu enables the user to make modifications to the drawing as desired. Select
the Erase command from the menu. Then, you may erase any object on the screen simply by
placing the cursor box anywhere on the object and preSsing the left mouse button. Go ahead
and erase the straight and curved segments on the drawing. Remember to cancel the repeating
command when finished. Similarly, you may erase several objects enclosed in a window using
the Erase Window command. The operation of the other editing features are explained in
Chapter 5.
The Display menu allows the user to zoom in, zoom out and pan around the drawing.
Select the Zoom In command and take a closer look at the drawing details. Then, Zoom Back
to your previous screen. The zoom functions will allow user to provide greater detail and
accuracy when the guidepath network or module is being drawn. In addition, Modify Layer
allows the user to select his or her favorite color or line type for each component of the drawing.
Refer to Chapter 5 for more details.
The Elements menu allows the user to see the information associated with the various
drawing elements and make changes. Select Segment Info (or Module Info) command from
the menu, and click on a segment (or a module) with the cursor box. The pop-up menu will
display the current attributes of the segment (or module). Each cell can be edited by placing the
arrow inside the cell box and typing in the new value.
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3.2 Data Input (through Dialog)
The Dialog menu contains the dialog routines. The dialog routines will allow user to
view, scan, edit, and print information contained in the neutral database. Select the Flow

Requirements command to view the current flow requirements for project DEM0_1. On a dualscreen system, the spreadsheet is displayed on the second screen. Use the cursor movement
keys on the keyboard to move around the spreadsheet and change any flow value. The changes
to the neutral database will not be made permanent unless the F1 key is pressed. Pressing the
F4 key will return you back to the drawing. You may now select the other commands in this
menu that operate basically the same way.

3.3 Reliability Analysis and Result Display
Now, pull down the Analysis menu and select the Update Flies command. This
command will activate a series of commands to extract needed information from the drawing,
convert .the extracted drawing information to its network representation, compute the shortest
I
paths and update the neutral database. Any problems detected by the conversion program will
be reported to the user. If there are any, correct the problems and update the files again. You
may end this session at any time with the Abandon command in the File menu.
When the Update Files is successful, the Reliability Analysis command is made
available; select this command. Then, the pie chart for breakdown of failures by component type
is displayed. By pressing any key, another pie chart for breakdown of task failures by requests is
displayed. Then, press •q• to view the trips with highest unavailability table. The corresponding
bar chart with top 1Oo/o unavailability is displayed by pressing F1. After viewing the bar chart,
return the key control back to loaded trip unavailability table by pressing the space key. Similarly,
the unloaded trip unavailability table, expected number of loaded trip failures table, expected
number of unloaded trip failures table, and expected number of transport task failures table are

displayed by pressing page-down key once, twice, three timEl,s, and four times respectively. You
may press F4 to quit the session or press page-up and page-down key to see those previous
tables or charts again.
After quitting the result display session, it can be brought back again by selecting Dialog,
then Result Display. The remaining operations are the same as previously mentioned.
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3.4 Other Utilities
Finally, the Snap and the Uti Is menus provide useful tools for efficient operation. The

Snap menu is used to change the snap and grid settings and activate the Osnap routines. The
Utils menu provides the Shell utility which enable user to access the DOS commands while
running the EWS. Select Shell and Return/Enter, then the DOS prompt will appear. Type

".EXJ.I"

to return back to AutoCAD when finishing DOS commands.
This concludes the walkthrough for the DEMO_1 pro]ect file. Feer free to explore the
menus for additional features not explicitly mentioned in this chapter. Refer to Chapter 5 for the
explanation of the EWS commands. Good luck! ..

3.5 Important Remarks
1. Use right-button of mouse or "C to cancel the active command in AutoCAD
2. Always turn the Snap on while drawing the blocks within EWS.
3. Always draw the figure on the first quadrant (i.e. both X-coor. and Y -coor. are positive).
Otherwise, the error message will occur when Updating Files.
4. Use F1 to toggle the key control between AutoCAD menu and AutoCAD command prompt if
one monitor is used or between two monitors if dual monitors are used ?

5. The following is the tip to draw a long segment. First, select Display menu, then Zoom In the
starting point of the segment. Select Layout menu to insert segment. Suppose the

Straight Segment command is chosen. Move the cursor to where the starting point is,
then press the left button of mouse to input the starting point. Next, pr·ass F1 to toggle
key control to AutoCAD command prompt. At this point, a message - "command: (setq
QC (getpoint qa)t is displayed. Simply input the coordinate of the end point from
keyboard by typing the X-coordinate, then a comma, followed by the Y -coordinate. For
instance, suppose the coordinate of the end point is (1 00, 250). Simply type "1 00.250",
then Return/Enter.
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6. Avoid drawing extremely short segments (straight or curved), since these segments are
likely to be confused with the internal representations of modules which are also short
segments. As a safety rule, a segment length should always be at least 4 units.
7. Each intersection point must have either a turnout or a turntable. Otherwise, Update Files
can not successfully executed, and an error message will be reported.
8. Two (curved) segments are drawn one after another when bi-directional (curved) segment
is selected. The first segment is drawn with the same starting and end points as you
specified. While the second segment is drawn right on top of the first segment with
reversed direction. If you draw the bi-directional segments from left to right, the bottom
one is from left to right while the top one from right to left.
9. Each modules must have a unique 3-characteriD. Otherwise, Update Flies can not
successfully executed, and an error message will be reported.
10. When the bi-directional (curved) segments are to be erased. Select the Ell'8se command,
point to the segments to be erased. Then click mouse button twice, since the two
segments are overlapped. Only the top segment is erased if mouse button is clicked
once.
11. When encountering the ·shell error: insufficient memory to execute the command•, you can
not continue to execute any command unless quitting the AutoCAD environment. Then
reenter the AutoCAD to resume other executions of commands.

3.6 Assumptions and Limitations
1. Maximal number of stockers allowed is 60.
2. Curved or inclined segments can not be split. Thus, no module can be allowed on any middle
point of the curved or inclined segments. However, it is allowed on both end points of the
curved or inclined segments.
3. As mentioned in previous section (3.5), two segments with identical end points but in opposite
directions will be inserted one after another when the Bi-directional Segment command
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is selected. The bottom segment can not be selected so that it can no1t be edited unless
the top segment is temporarily moved away.
4. All the bar charts display only up to 16 data items.
5. All the pie charts display only up to 16 data items.
6. Maximal MTBF that can be entered for each module is 9,999,999.99. Numbers greater than
this should be entered as infinity (by inputting -1 from the keyboard) .
7. Maximal Operation Time allowed for each module is 9,999.99.
8. Maximal Remark allowed for each module is 15 characters.
9. Maximal number of module types which can be entered from dialog program is 17.
10. The module type ID length is limited to two characters. The unique module ID length is
limited to three characters.
11. Empty vehicle dispatching is based on factoring (or FCFS) rule.
12. Vehicles travel at constant speed on the same segment. Speed on different segments can
be adjusted by multiplying the speed by the speed factor of that segment.
13. The MTBF of each module type is the mean operating time of that module type between two
consecutive failures. This does not include the time periods in which the component is
idle or shut down.
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4 An Illustrative Example
In this chapter we use an example to illustrate how to utilize FRAME to perform reliability
analysis. This example is included in the installation package and you can use it to test this
software.

Legend: TT= Turntable; HT= Horizontal Transfer; AS/AS= Stocker

Figure 4.1 AMHS layout

4.1 System Description

System layout shown in Figure 4.1 consists of the following components:

•

ProgrammaTrak monorail track There is approximately 1400 linear feet of track in a

dual lane layout servicing all process aisles. Each track segment is unidirectional; the inside
track runs clockwise whereas the outside track runs counterclockwise.
•

Horizontal transfers There are 14 transfers off the track , each servicing one stocker.
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•

Turntables There are 4 dual lane turntables. They are installed at the four comers of

the entire track to allow cars to switch track
•

Transport car The ProgrammaTrak transport cars with fixture carries a single lot box..

•

Automated work-in-process storage and retrieval units There are 14 PRI WIP units

(stockers) in the system. Each unit includes robotics, AS/RS unit control software, operator and
host interfaces. The units are of varying capacity and configuration to meet specific process or
layout requirements.

In addition to the above supplier components, the user hae also developed a Material
Control System (MCS) to manage the AMHS, along with an interface to the plant logistics
control system.

The transport requirements matrix is shown in Table 4.1. This matrix is entered into
FRAME by selecting command Flow Requirements in menu Dialog.

Fr/To ·aN
8N
0
6N
0
7S
0
7N
0
5N
4
6S
0
4N
8
5S
4
0
3N
4S
4
2N
8
4
2S
4
1N
1S
0
Total 36

6N
4
0
0
3
13
0
7
9
0
8
0
0
7
6
57

Table4.1 Transport RleqUirements for 0 ne Shift
7N 5N
6S 4N 5S 3N 4S 2N 2S
7S
0
3
0
0
3
4
13
5
0
7
5
1
0
0
41

0
5
0
0
5
4
11
3
0
9
7
3
4
0
51

5
6
4
5
0
7
19
0
0
17
12
7
11
3
96

8
0
0
1
11
0
9
7
0
4
0
0
5
2
47

0

9
12
13
17
7
0
16
3
0
19
11
17
9
133

3
10
4
3
0
9
17
0
0
15
8
5
5
5

84

0
0
0
0
0
0
0
0
0
0
4
4
0
0
8

0
7
8
7
15
5
0
16
1
0
13
13
11
7
103

10
5
7
8
8
4
13
8
3
9
0
0
8
5
88

6
3
5
4
8
4
7
4
1
7
0
0
4
3
56

1N
0
6
4
4
8
3
17
7
0
15
9
3
0
0
76

1S Total
36
0
2
56
0
44
48
0
4
96
48
1
11
132
5
84
8
0
13 108
3
88
52
1
0
76
40
0
40 916

The normalized MTBF of all component types is shown in Table 4.2. This data is
entered into FRAME by selecting command Module Type Info in menu Dialog.
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Component ID
vh
ht

tt
sr

Table 4.2 MTBF om
f od ue
I trypes
MTBF(hr)
0~. time(sec)
814.0
travel time
163.2
6
427.9
10
7.06
20

Remark
transport car
horizontal transfer
turntable
stocker

In addition to the above data, the following parameters concerning the operation of the
system also need to be entered into FRAME:
•

The transport car travels at the same constant speed of 70 ftlmin whether loaded or empty.

•

Horizontal transfers operate 6 seconds for one transaction (turning the car off or onto the
track).

• . Turntables operate for 10 seconds per transaction.
•

AS/AS operate 20 seconds per storage or retrieval.
The transport car speed is entered by selection command Vehicle and MCS Specs in

menu Dialog. The operating times of the other three module ~ypes are entered by selecting
command Module Type Info .

4.2 Reliability Analysis

Now with the system layout created, various operating parameters and module type
information entered into the computer, the reliability analysis is performed by simply selecting
command Update Files and then selecting command ReliabUity Analysis in menu Analysis.
The rest is automatically performed by the computer.
When the analysis is complete, the following information will be displayed on the screen:
1 Trip unavailability The loaded trip unavailability table is something like Table 4.3, and the
unloaded unavailability table looks like Table 4.4. If you press the key F1, a corresponding bar
chart will display the 20°/o of the entries with the highest values. These are the most unreliable
trips in the system.
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Fr/To
N8
N7
57
N6

N8

N7

57

N6

Table 4 3 Loadad tri :> unavailabT
1ity
N4.
NS
56
54
N3
55

0.0000 0.0018 0.0017 0.0016 0.0017 0.0019 0.0017 0.0019 0.0017 0.0019 0.0017
o.oo17 0.0000 0.0017 0.0016 0.0016 0.0019 0.0017 0.0019 0.0017 0.0018 0.0017
~0017 0.0017 0.0000 0.0017 0.0017 0.0018 0.0018 0.0018 0.0018 0.0018 0.0018
o.oo19 0.0020 0.0019 0.0000 0.0016 0.0019 0.0016 0.0018 0.0016 0.0018 0.0017

NS

~.0018

56
N4

0.0018 0.0017 0.0018 0.0017
0.0018 0.0019 0.0019 0.0018
p.oo18 0.0017 0.0018 0.0018
o.oo18 0.0019 0.0018 0.0018
0.0018 0.0017 0.0018 0.0018

55
N3
54

N2

0.0020 0.0019 0.0018 0.0000 0.0018 0.0016
0.0018 0.0000 0.0018
0.0018 0.0018 0.0000
0.0018 0.0016 0.0018

52

N1

51

0.0018 0.0017 0.0018
0.0018 0.0017 0.0018
0.0018 0.0018 0.0017
0.0018 0.0017 0.0018

0.0018 0.0016 0.0018 0.0017 0.0018
0.0018 0.0018
0.0016 0.0018
0.0018 0.0018

0.0017 0.0018

0.0018 0.0018 0.0018
0.0018 0.0016 0.0018
0.0000 0.0018 0.0018
0.0018 0.0018 0.0018 0.0018 0.0000 0.0018

0.0018 0.0018
0.0016 0.0017
0.0018 0.0018
0.0016 0.0017 0.0016 0.0017
0.0016 0.0018 0.0000 0.0018 0.0018 0.0019 0.0018
0.0017 0.0018 0.0017 0.0000 0.0017 0.0016 0.0017
0.0016 0.0018 0.0016 0.0019 0.0000 0.0019 0.0018
0.0017 0.0018 0.0017 0.0018 0.0017 0.0000 0.0017

N1

0.0018 0.0016 0.0018
0.0018 0.0019 0.0018 0.0017 0.0018 0.0018 0.0018
Q.0018 0.0018 0.0019 0.0018 0.0018 0.0016 0.0018
0.0018 0.0019 0.0018 0.0017 0.0018 0.0018 0.0018

51

p.0018 0.0018 0.0019 0.0018 0.0018 0.0017 0.0019 0.0016 0.0019 0.0016 0.0019 0.0016 0.0019 0.0000

N2
52

Ta bl e 4 4 U nloaded t np
. unava1·1ab'lit
1 [y_
Frrro
N8
N7
57
N6
N5
56
N4
55
N3
54
N2

N8

N7

57

N6

N5

S6

0.0000 0.0002 0.0001 0.0001 0.0001 0.0003
0.0001 0.0000 0.0001 0.0000 0.0001 0.0003
0.0002 0.0001 0.0000 0.0001 0.0002 0.0002
0.0003 0.0004 0.0003 0.0000 0.0000 0.0003
o.o003 0.0004 0.0003 0.0002 0.0000 0.0003
0.0002 0.0001 0.0002 0.0002 0.0002 0.0000

N4

55

N3

0.0001 0.0003 0.0001
0.0001 0.0003 0.0001
0.0002 0.0002 0.0002
0.0001 0.0003 0.0001
0.0000 0.0002 0.0001

54

N2

52

51

N1

0.0003 0.0002 0.0003 0.0002
0.0003 0.0001 0.0003 0.0001
0.0002 0.0002 0.0002 0.0002
0.0003 0.0001 0.0002 0.0001
0.0002 0.0001 0.0002 0.0001

0.0003
0.0002

0.0002 0.0002 0.0002 0.0002 0.0002 0.0002 0.0003
0.0002 0.0004 0.0003 0.0002 0.0002 0.0002 0.0000 0.0002 0.0000 0.0002 0.0001 0.0002 0.0001
0.0002 0.0002 0.0003 0.0002 0.0002 0.0000 0.0002 0.0000 0.0002 0.0002 0.0003 0.0002 0.0003
0.0002 0.0003 0.0003 0.0002 0.0002 0.0002 0.0002 0.0002 0.0000 0.0002 0.0000 0.0002 0.0001

0.0002

0.0002
0.0002
0.0002
0.0002
0.0002
0.0002

0.0002 0.0002 0.0003 0.0002 0.0002 0.0000 0.0002 0.0000 0.0002 0.0000 0.0003 0.0002 0.0003 0.0002
0.0002 0.0003 0.0002 0.0002 0.0002 0.0002 0.0002 0.0002 0.0002 0.0002 0.0000 0.0001 0.0000 0.0001

52

0.0002 0.0002 0.0003 0.0002 0.0002 0.0001 0.0003 0.0001 0.0003 0.0000 0.0003 0.0000 0.0003 0.0002

N1

0.0002 0.0003 0.0002 0.0002 0.0002 0.0002 0.0002 0.0002 0.0002 0.0002 0.0002 0.0001 0.0000 0.0001

51

0.0003 0.0002 0.0003 0.0002 0.0003 0.0001 0.0003 0.0001 0.0003 0.0001 0.0003 0.0000 0.0003 0.0000

2 Expected number of trip failures The expected number of loaded trip failure table is
something like Table 4.5, and the expected number of unloaded trip failure table looks like Table
4.6. If you press the key F1, a corresponding bar chart will display the 20% of the entries in the
table with the highest values. These are the trips that have the highest expectEKi loaded or
unloaded trip failures in the system.
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Ta ble 4 5 Loaded t np
. fa1·1 ures
Fr!To

N8
N7
S7
N6
N5
S6
N4
S5
N3
S4
N2
S2
N1
S1

N8

N7

S7

N6

Q.OOOO 0.0000 0.0000 0.0066
0.0000 0.0000 0.0000 0.0049
0.0000 0.0000 0.0000 0.0000
P.OOOO 0.0099 0.0057 0.0000
0.0074 0.0098 0.0056 0.0235
0.0000 0.0069 0.0072 0.0000
0.0146 0.0213 0.0242 0.0125
0.0072 0.0052 0.0091 0.0158
0.0000 0.0000 0.0000 0.0000
0.0072 0.0157 0.0129 0.0141
0.0142 0.0132 0.0091 0.0000
P.0073 0.0053 0.0019 0.0000
P.0071 0.0075 0.0000 0.0122
p.oooo 0.0000 0.0000 0.0109

N5

S6

N5

0.0083
0.0082
0.0069
0.0097
0.0000
0.0123
0.0344
0.0000
0.0000
0.0304
0.0212
0.0127
0.0193
0.0055

0.0152
0.0019
0.0000
0.0000
0.0202
0.0000
0.0163
0.0113
0.0000
0.0065
0.0000
0.0000
0.0088
0.0033

0.0000
0.0216
0.0211
0.0147
0.0275
0.0125
0.0000
0.0288
0.0054
0.0000
0.0339
0.0201
0.0302
0.0167

T a ble4.6.
Fr!To

N8

N7

S7

N8
N7
S7
N6
N5
S6
N4
S5
N3
S4
N2
S2
N1

0.0000
0.0002
P.0003
0.0006
b.0010
0.0004
0.0013
0.0007
0.0001

0.0004
0.0000
0.0002
0.0012
0.0019
0.0004
0.0025
0.0007
0.0001

0.0002
0.0003
0.0000
0.0009
0.0014
0.0005
0.0018
0.0010
0.0001

S1

N6

0.0001
0.0001
0.0004
0.0000
0.0014
0.0005
0.0017
0.0009
0.0001
0.0009 0.0009 0.0013 0.0012
0.0007 0.0015 0.0010 0.0009
0.0005 0.0006 0.0008 0.0007
0.0006 0.0012 0.0009 0.0008

S5

N3

S4

N2
0.0056 0.0000 0.0000 0.0172
0.0056 0.0000 0.0129 0.0136
0.0071 0.0000 0.0142 0.0126
0.0183 0.0000 0.0128 0.0084
0.0000 0.0000 0.0271 0.0133
0.0163 0.0000 0.0090 0.0073
0.0305 0.0000 0.0000 0.0213
o.o6oo 0.0000 0.0291 0.0147
0.0000 0.0000 0.0018 0.0049
0.0240 0.0000 0.0000 0.0166
0.0140 0.0072 0.0226 0.0000
0.0081 0.0074 0.0210 0.0000
0.0087 0.0000 0.0191 0.0146
0.0082 0.0000 0.0115 0.0095

S2

N1

S1

0.0111
0.0073
0.0088
0.0054
0.0143
0.0071
0.0123
0.0072
0.0017
0.0126
0.0000
0.0000
0.0068
0.0048

0.0000
0.0068
0.0072
0.0101
0.0133
0.0055
0.0279
0.0129
0.0000
0.0278
0.0144
0.0056
0.0000
0.0000

0.0000
0.0000
0.0000
0.0036
0.0070
0.0018
0.0191
0.0089
0.0000
0.0231
0.0051
0.0018
0.0000
0.0000

Unoa
I ded tnp
. failures

N5

S6

N4

S5

N3

0.0003
0.0003
0.0007
0.0002
0.0000
0.0009
0.0033
0.0018
0.0002
0.0023
0.0018
0.0014

0.0006
0.0008
0.0005
0.0008
0.0013
0.0000
0.0017
0.0002
0.0001
0.0003
0.0009
0.0002

0.0006
0.0006
0.0011
0.0005
0.0006
0.0014
0.0000
0.00';.7

0.0010
0.0013
0.0008
0.0013
0.0021
0.0010
0.0027
0.0000
0.0001
0.0003
0.0014
0.0003
0.0012

0.0000
0.0000
0.0001
0.0000
0.0000
0.0001
0.0000
0.0002
0.0000
0.0002
0.0002
0.0001

0.0003
~.0034

0.0027
0.0021

0.0015 0.0008 0.0023
0.0004 0.0004 0.0006 0.0006 0.0011 0.0002 0.00'16

S4

0.0012
0.0016
0.0010
0.0017
0.0026
0.0012
0 .0033
0.0024
0.0002
0.0000
0.0017
0.0003
0.0002 0.0014
0.0003 0.0001 0.0003

N2

S2

N1

S1

0.0005
0.0006
0.0009
0.0006
0.0008
0.0011
0.0008
0.0022
0.0000
0.0027
0.0000
0.0016
0.0018
0.0012

0.0005
0.0007
0.0004
0.0007
0.0011
0.0005
0.0014
0.0010
0.0001
0.0013
0.0007
0.0000
0.0006
0.0001

0.0005
0.0006
0.0008
0.0005
0.0007
0.0010
0.0008
0.0019
0.0000
0.0024
0.0002
0.0014
0.0000
0.0011

0.0004
0.0005
0.0003
0.0005
0.0008
0.0004
0.0010
0.0007
0.0000
0.0009
0.0005
0.0006
0.0004
0.0000

3 Expected number of transport task failures The expected number of transport task failure
table is something like Table 4. 7. If you press the key F1,
the

a corresponding bar chart will display

20°/o of the entries in the table with the highest values. These are the tasks that have the
i

highest expected number failures under the current flow requirement and the empty transport car
dispatching rule.
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Table 4 7 E:xpected num berof tas k fa1'I ures

Frrro
N8
N7
57
N6
N5
56
N4
55
N3
S4
N2
52
N1
51

N8

N7

57

N6

0.0000 0.0000 0.0000 0.0074
Q.OOOO 0.0000 0.0000 0.0056
0.0000 0.0000 0.0000 0.0000
0.0000 0.0107 0.0062 0.0000

N5
0.0094
0.0094
0.0079
0.0107

56

N4

S5

0.0169 0.0000 0.0063
0.0021 0.0248 0.0063
0.0000 0.0240 0.0081
0.0000 0.0162 0.0200

N3

S4

N2

S2

N1

0.0000
0.0147
0.0162
0.0140

0.0194 0.0124 0.0000
0.0156 0.0083 0.0078
0.0143 0.0100 0.0082
0.0092 0.0059 0.0111
0.0080 0.0106 0.0061 0.0257 0.0000 0.0220 0.0302 0.0000 0.0000 0.0295 0.0146 0.0156 0.0146
0.0000 0.0076 0.0079 0.0000 0.0135 0.0000 0.0137 0.0178 0.0000 0.0098 0.0080 0.0078 0.0060
0.0158 0.0229 0.0261 0.0136 0.0372 o.o1n 0.0000 0.0330 0.0000 0.0000 0.0232 0.0134 0.0305
0.0000
0.0000
0.0000
0.0000

51
0.0000
0.0000
0.0000
0.0039

o.oon
0.0019

0.0208
0.0078 0.0057 0.0100 0.0173 0.0000 0.0124 0.0314 0.0000 0.0000 0.0317 0.0160 0.0078 0.0141 0.0097
0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0059 0.0000 0.0000 0.0019 0.0054 0.0019 0.0000 0.0000
0.0079 0.0173 0.0141 0.0155 0.0334 0.0072 0.0000 0.0267 0.0000 0.0000 0.0182 0.0138 0.0305 0.0254
0.0156 0.0144 0.0099 0.0000 0.0232 0.0000 0.0372 0.0154 0.007& 0.0248 0.0000 0.0000 0.0159 0.0056
0.0080 0.0058 0.0020 0.0000 0.0139 0.0000 0.0221 0.0090 0.0081 0.0234 0.0000 0.0000 0.0062 0.0020
o.oon 0.0082 0.0000 0.0133 0.0211 0.0096 0.0329 0.0095 0.0000 0.0208 0.0158 0.0075 0.0000 0.0000
0.0000 0.0000 0.0000 0.0119 0.0060 0.0037 0.0182 0.0091 0.0000 0.0127 0.0103 0.0054 0.0000 0.0000

4 Breakdown of task failures by component types This pie chart on the screen displays the
expected task failure numbers as well as their percentage attributed to different component
types. It gives an idea of which component types are causing the most reliability problems within
the system.

5 The Most critical components FRAME will automatically highlight in the system layout
drawing those individual modules (as opposed to module types) that have the highest expected
number of task failures. These are the most critical components that should tH~ aimed at while
trying to improve the system reliability.

24

5. The EWS Commands
The individual commands are grouped under the menu names at whk:h they belong. The
menu names are listed in the same order as they appear on the screen.
NOTE: Several menu commands repeat automatically. In order to terminate a repeating
command, the user may press the right button on the mouse, or select the Cancel
command from the Edit menu, or enter a~ (Ctrl key pressed simultaneously with letter
C) from the keyboard.
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FILE

================================•az==•-=-sz==========•==================
Save saves the currently active drawing file to disk.
Save As saves the currently active drawing file under a new name.
Close ends the current AutoCAD™ editing session. The current drawing file Is saved to disk,
and the user is returned to DOS.
Abandon abandons all modifications made to the drawing during the current editing session.
The user is returned to DOS.
Open abandons all modifications made to the drawing during the current editing session and the
user is allowed to load another project file.
Plot plots the currently active drawing. AdditiOnal information must be supplied by the user to
specify the plot size. The current drawing file remains active.
Print prints the currently active drawing. Additional information must be supplied by the user to
specify the plot size. The current drawing file remains active.
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LAYOUT
=======================-----~===~-------··=======···=======··=========

Insert (With Split):
Straight Segment inserts a straight guidepath segment Into the layout. The user is prompted
for the two endpoints of the straight segment. The end~ints are checked to see
whether they lie along the interior of previously Inserted guidepath segments. If so, that
guidepath segment is split before the new segment is inserted.
Bidirectional Segment insert two straight guidepath segments in opposite direction. The user
is prompted for the two endpoints of a straight segment. Its operation and general
attributes are same as above.
Reverse of Segment Asks the user to point to a straight segment and inserts another straight
guidepath segment in opposite direction. Its operation and general attributes are same
as a straight segment. This selection can be used to make an existing segment bidirectional.
Curved Segment inserts a curved guidepath segment into the layout. The user is prompted for
the beginning point of the curved segment, the curve radius, and the curve orientation
(the latter is chosen from an icon menu). This command will always draw the curve as a
quarter circle. The two endpoints of the curve are checked to see whether they lie along
the interior of previously inserted guidepath segments. If so, the guidepath segment(s)
will be split before the new curved segment is inserted.
Turntable inserts a turntable into the layout. The user is prompted for the location of the
turntable. Then the user is asked to enter the attributes associated with the turntable just
being inserted. If the insertion point falls on an existing segment, the :segment is split into
two segments.
Turnout inserts a turnout switch Into the layout. The user is prompted for the location of the
turnout. Then the user is asked to enter ·the attributes associated with the turnout just
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being inserted. If the insertion point falls on an existing segment, the segment is split into
two segments.
Stocker inserts a stocker and a transfer into the layout simultaneously. The user is prompted
for the location of the transfer (with stocl(er). Then the user is asked to enter the
attributes associated with the stocker and transfer just being inserted. If the insertion
point falls on an existing segment, the segment is split into two segments.
Transfer inserts a horizontal transfer into the layout. The user is prompted for the location of the
horizontal transfer. Then the user is asked to enter the attributes associated with the
horizontal transfer just being inserted. If the insertion point falls on an existing segment,
the segment is split into two segments.
Vertical Transfer inserts a vertical transfer into the layout. The user is prompted for the location
of the vertical transfer. Then the user is asked to enter the attributes associated with the
vertical transfer just being inserted. If the insertion point falls on an existing segment, the
segment is split into two segments.
Split Straight Segment splits a straight guidepath segment into two separate segments. The
user is prompted for the position at which the split will be made.
Join Two Segments combines two contiguous straight guidepath segments into a single
segment. The user is prompted for the position at which the two segments are to be
joined.
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LAYOUT

================•======zz-===·===··====-·=-·=============================
Insert (Without Split):
Straight Segment inserts a straight guldepath segment into the layout. The user is prompted
for the two endpoints of the straight segment. However,

l'·i

split will not occur.

Bidirectional Segment insert two straight guidepath segments in opposite direction. The user
is prompted for the two endpoints of a straight segment. However, a split will not occur.
Reverse of Segment Asks the user to point to ~~ straight segment and Inserts another straight
guidepath segment in opposite direction. However, a split will not occur. This selection
can be used to make an existing segment bi-directk>nal. ·
Curved Segment inserts a curved guidepath segment into the layout. The user is prompted for
the beginning point of the curved segment, the curve radius, and the c:urve orientation
(the laHer is chosen from an icon menu). This command will always draw the curve as a
quarter circle. However, a split will not occur.
Turntable inserts a turntable into the layout. The user is prompted for the location of the
turntable. Then the user is asked to enter ·the aHributes associated with the turntable just
being inserted. However, a split will not C)Ccur.
Turnout inserts a turnout switch into the layout. The user is prompted for the location of the
turnout. Then the user is asked to enter the attributes associated with the turnout just
being inserted. However, a split will not ()CCUr.
Stocker inserts a stocker and a transfer into the layout simuhaneously. The user is prompted
for the location of the transfer (with stocker). Then the user is asked to enter the
aHributes associated with the stocker and transfer just being inserted. However, a split
will not occur.
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Transfer Inserts a horizontal transfer into the layout. The user is prompted for the location of .the
horizontal transfer. Then the user Is aslced to enter the attrbutes as..4K>Ciated with the
horizontal transfer just being inserted. However, a split will not occur.
Vertical Transfer inserts a vertical transfer into the layout. The user is prompted for the location

of the vertical transfer. Then the user is asked to enter the attributes associated with the
vertical transfer just being Inserted. However, a split will not occur.
Split Straight Segment splits a straight guldepath segment into two separate segments. The
user is prompted for the position at which the split will be nlade.
Join Two Segments combines two contiguous straight guldepath segments into a single
segment. The user is prompted for the position at which the two segments are to be
joined.
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SKETCH

=========================-·-==========•=================:================
Line draws a single straight line. The user Is prompted for the two endpoints of the iine.
Circle draws a circle. The user is prompted for the center and the radius of the circle.
Arc draws.a portion of a circle. The user is prompted for the center of the circle, one endpoint of
the arc, and the angle which is swept out by the arc.
Box draws a rectangular box. The user is prompted for opposite comers of the box.
Text allows ·the user to place text on the drawing. The user is prompted for the starting point of
the text, the text height, and the text.
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EDIT

Erase W/ Join erases any visible element on the drawing file. The user is prompted to select
the object to be erased. If there are two segments, one starting and another ending, at
the insertion point of the object, these two segments will be joined Into one segment.
Note that it is not recommended to erase a module by this commarid when It is located at
the intersection where segments with different types (for instance, one uni-directional,and
another bl-directionaQ are joined. In this case, use Erase W/0 Join to erase the module.
Erase W/0 Join erases any visible element on the drawing file. The user is prompted to select
the object to be erased. However, no •Join• operation is performed after the module is
erased.
Erase Window erases all elements which are entirely contained within a specified window. The
user is prompted to enter the two opposite comers of the window.
UnErase undoes the last erase command.
Move W/ Join & Split moves a selected object from one point to another. The user is prompted
for the object to be moved, the point 'that it will be moved from, and the point it will be
moved to. If the moved object is a straight segment, this command afso performs the
•Join• and •sp11t• operation at the two endpoints of the segment. However, this
command Is not recommended for the beginners.
Move W/0 Join & Split moves a selected object from one point to another. The user is
prompted for the object to be moved, the point that it will be moved frc,m, and the point it
will be moved to.
Move Window moves all objects which are entirely contained within a specified window. The
user is prompted for the opposite comers of the window, the point frorn which the
collection of objects will be moved, and the point to which they will be moved to.
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Copy makes a copy of a selected object. The user is prompted for the object to be copied, the
location of a reference point for the original, and the location of the corresponding point
for the copy.
Copy Window copies all objects which are entirely contained within a specified window. The
user is prompted for opposite comers of the window. the location of a reference point for
the originals. and the location of the corresponding point for the copiE~.
Rotate rotates a selected object. The user is prompted for the object to be rotated, the pivot
point, and the angle of rotation. The angle of rotation (~~~ degrees) inc:reases
counterclockwise. Negative angles are permissible.
Rotate Window rotates a group of objects contained entirely within a specified window. The
user is prompted for opposite comers of the window, the pivot point about which the
group of items will be rotated. and the angle of rotation. The angle of rotation (in
degrees) increases counterclockwise. Negative angles are permissible.
Reverse Straight Segment reverses the direction of travel along a straight segment. The user
is prompted for the segment to be reversed. This command is for uni-directional straight
segments only.
Reverse Curved Segment reverses the direction of travel along a curved segment. The user is
prompted for the curved segment to be reversed. This command is for uni-directional
curved segments only.
Stretch Segment increases the length of a guidepath segment. The tail endpoint of the
segment remains at the same location, while the segment is •stretched•. The attributes
associated with the segment (i.e., the segment labe~ are not affected. This command is
for uni-directional straight or curved segments only.
Shrink Segment decreases the length of a guidepath segment. The tail endpoint of the
segment remains at the same location, while the segment is •shrunk•. The attributes
associated with the segment (i.e .• the segment label) are not affected. This command is
for uni-directional straight or curved segments only.
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Rescale Modulu changes the size of all the modules Including turntables, turnouts, stockers,
horizontal transfers, and vertical transfers. The user is prompted for the scale factor.
The modules will be drawn in size equal to the scale factor times their current size. The
scale factor may be smaller than 1, but not zero.
Rescale Layout rescales the entire layout drawing. The scale factor may be smaller than 1, but
not zero. For example. a scale factor of 2 means that all drawing element dimensions
will be multiplied by 2.
Undo undoes the results of the previously selected menu comrridnd. Users may need to click
Undo several times to finally undo the commands since each menu command performs
a series of AutoCAD commands.
Redo restores the previously undone command.
Cancel cancels the currently active command.

r

I
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DISPLAY
================•=======z=--=====~=-======•=========c==================

Zoom In zooms in on the portion of the drawing contained within a specified window. The user
is prompted for opposite comers of the zoom window.
Zoom Back returns to the view which was displayed prior to the last Zoom or Pan command.
Zoom All displays the entire limits of the drawing.
Zoom To Fit displays the minimum area large enough to contain all elements in the drawing.
Zoom Dynamic displays a dynamic box - whose size and location can be adjusted representing the area to zoom in.
Pan moves the current display on the virtual screen.
Redraw redraws the elements on the screen deleting all blips and regenerates the edited
portions of the drawing elements. We suggest generous use of this command during
editing sessions.
Turn Hilight ON highlights all critical modules. Note that this command doesn't work until
Reliability Analysis is done.
Turn Hilight OFF returns all previously highlighted modules to their original coior.
Hilight Display% allows the users to specify the percentage of critical modules to be displayed.
For example, select this command and type '0.2' or '.2' then 'Ente,.. to SE~t display
percentage to 20%. Note that the numbers typed are not shown on the screen. The
default is set to 0.1, i.e. 1Oo/o.
Turn Arrowheads ON makes all the arrowheads the same size. Draws the arrowheads of
certain size on different layer (named •Arrowheads'•) to cover the original arrowheads of
different sizes so that the arrowheads are more visible.
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Rescale Arrowheads changes the size of the arrowheads. It can only change the size of the
arrowheads which are • Turned on• (I.e. on layer • Arrowheads• .)
Tum Arrowheads OFF removes from screen the arrowheads which are added by •rum
Arrowheads On•.
Display Ctrl. Pt. IDs displays all the control point IDs on thEt screen.
Remove Ctrl. Pt. IDs erases all the control point IDs from the screen.
Modify Layer activates a dialog box which provides a variety of functions relating to layers:
turning layers on and off, changing the active layer, changing the color or line type of
layers, creating new layers, etc.
NOTE: The components and the layers on which they are drawn are listed below.

Component

Layer Name

all the modules (turntables, .. etc.)

modules

all uni-directional segments

zero (o)

all bi-directional segments

twoway

all backgrounds (text, line, ... etc.)

machines

arrow heads

arrowheads

control points

controlpoints

•• Line types can be modified by editing the file: ACAD.LIN under the directory where
ACAD"' is stored.
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ELEMENTS

=============================·=··==========================================
Update Flies updates the neutral data files. This command must be chosen after changes are
made to the drawing in order to insure that the analysis routines use 'the latest
information. Before the data files are updated, the other selections available from this
menu are •grayed out• and cannot be selected.
Segment Info command activates a dialog box which allows the user to edit the information
associated with ·the selected guidepath segment.
Module Info command activates a dialog box which allows the user to edit the information
associated with the selected module.
Segment List command runs an external program which lists all segment-related data since the
last ·update Files• command. This command can be used to view segment information
sorted in various ways and also to obtain a hardcopy listing.
Module List command runs an external program which lists all module-reia'led data since ·the
last ·update Files• command. This command can be used to view module information
sorted in various ways and also to obtain a hardcopy listing.
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ANALYSIS
====================-·~----·----=-==-==-=-=============================

Update Flies updates the neutral data files. This command must be chosen after changes are
made to the drawing in order to insure that the analysis routines use the latest
information. Before the data files are updated, the other selections available from this
menu are •grayed out• and cannot be selected.
Reliability Analysis command executes the reliability model and displays the results on the
screen. The results include: (0 breakdown of failures by component type; (ii) breakdown
of task failures by requests; (iii) loaded/unloaded trip unavailability; (iv) expected number
of loaded/unloaded trip failures; (v) expected number of transport task failures.
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DIALOG
===============-=======·==-===·=-··=---==·=·=-~·-=======================

Update Files updates the neutral data files. This command must be chosen after changes are
made to the drawing in order to Insure that the analysis routines use Jthe latest
information. Before the data files are updated, the other selections available from this
menu are •grayed out• and cannot be selected.

I

I

I

Flow Requirements allows the user to view or update the flow rate data (usually called the
from-to matrix). This matrix defines the flows between each pair of {P, D) stations
associated with two stockers. Users may also specify (or edit) the fk)W requirements by
moving the cursor to the desired location within the matrix and typing the value on the
command line. The active function keys are displayed at the bottom line.

Module Type Info allows the user to specify the module information including module type 10,
Mean Time Between Failure (MTBF), operation time, and remarks. The MTBF can be
infinite by inputting• -1·.

Vehicle & MCS Specs allows the user to view and edit the specifications for both the vehicles
and material control systems (MCS). These include vehicle top speed, vehicle MTBF,
vehicle loaded speed adjustment, and MCS MTBF. The MTBF can be infinite by
inputting

·o·.

Result Display command is to display the computational result of the reliability model as those
shown after the •Reliability Analysis• is done.

Profile allows the user to view the project profile for the currently active project. The user can
move between the data fields using the cursor movement keys on the keyboard. The
information on each cell can be changed by entering the value at the prompt line.
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SNAP

=========================··========-====----====-========:===============
Snap/Grid command activates a dialog box which allows the user to alter the snap and grid
settings. The snap spacing sets the minimum pointer resolution. When the snap mode
is turned on, an invisible snap grid is activated, and only the points which are on the grid
can be selected. The X Base and Y Base settings specify the origin of the snap grid.
For example, if the snap spacing is set to 1.0000 unit and the X and Y Bases are set to
0.0000, only Integer positions will be allowed when snap mode is on. A visible reference
grid and axis markings can be used as drawing aids, and the appropriate settings for
these items are also specified in this dialog box.
Aperture sets the sensitivity with which objects are selected. The user is prompted to enter a
target height, in pixels, which specifies how far away from the cross-hairs an object can
be located and still be selected.
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UTILS

==============================·==========================================
Shell utility allows the user to run DOS commands and come back to EWS without effecting.
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APPENDIX A Quick References for Building the EWS
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A.1. Customizing AutoCAD

You can extend AutoCAD's capabilities and customize it for your application by designing
your own menus and libraries to complement those supplied with the program. The file used to
create custom AutoCAD menus is a text file with the type •.mnu• containing AutoCAD command
strings. Sections of the file can be associated with different menu devices, such as the screen
and tablet menus. To construct a custom menu, use a text editor (such as Brief) or a word
processor (such as Word) in •programmer- mode; you don't want the editor to put in extra
characters, indentation, etc.
Each menu item may consist of a command, a parameter, or a sequence of commands
and parameters. Normally, each menu item resides on one line of the file.

OOIE:

If you intend to supply command parameters as part of a menu item, you must be very
familiar with the sequence in which that command expects its parameters. Every
character in a menu item is significant, even the blank spaces. From time to time as
AutoCAD is revised and enhanced, the sequence of prompts for various commands (and
·sometimes even the command names) may change; your custom menus may require
minor changes when you upgrade to a new version of AutoCAD.
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A.1.1. Menu File

Sectjon Labels
A menu file can be logically broken into several sections, identified by section labels.
Each section belongs to a different menu device and contains command strings targeted for that
device. The section labels are:
***SCREEN

- Screen menu area

***POPn

- Pull-down menu area (where n is a numher from ·1 to 10)

***ICON

- Icon menu area

***BUTTONS

- Pointer device button menu

***TABLETn

- Tablet menu area (where n is a number from 1 to 4)

*** AUX1

- Auxiliary ,unction bo)( button menu

These labels specify that subsequent menu items, up to the next section label or the end
of file, belong to a specific menu device.
Submenu Oefjnition
A submenu label marks the start of a submenu. It has the format:
**name

The .. name.. is a string up to 31 characters long containing letters, digits, and thE~ special
characters ..$., •-• and •_•. The submenu label must reside on a menu file line by itself and must
not contain embedded blanks. All submenu names within a file must be unique. Menu items that
immediately follow a submenu label, up to the next submenu label, section label, or end of file,
belong to that submenu label.
Submenu Reference
You use the following construct within a menu item to activate or deactivate a submenu:

$section= submenu

where:
section

Specifies the menu section. Valid names are:
S

(for the SCREEN menu)

P1 - P1 0

(for POP menus 1 through 10)

I

(for the ICON menu)

44

B

(for the BUTTONS menu)

T1- T4

(for TABLET rtl4~nus 1 through 4)

A1

(for the AUX1 menu)

Submenu Specifies which submenu to activate. The name must be either one of the
submenu labels (without the ••••) in the currently loaded menu file or a menu section names as
defined above.
Examples:
$S=PARTS
$P7=P78
NQIE: You can use the special command ·sPn=·· (from within any menu item) to force the
menu currently assigned to area •popn• to appear (pull down) on the screen.

A.1.2. Icons

In AutoCAD, a slide is a file containing a •snapshot• of the display on the graphics
monitor. Usually a slide can be created to represent an icon for special application. You can use
ordinary AutoCAD commands to obtain the desired view on the monitor and then make a slide of
that display. The MSLIDE command is used to make a slide of current viewport. First, create
the display you wish to save, then enter:
Command:

MSLIDE

Slide file <default>:: (name)

The current drawing name is offered as a default. Press RETURN if you wish to use it.
A file type of •.sid• is appended to the name you apply; do not include a file type in your
response.
You can construct slide libraries from •.sld• files by using the SLIDELIB utility -program
supplied on the AutoCAD •support• disk. To construct a slide library, enter command:
C:\ACAD > slidelib library

[<slid~

at the operating system command prompt. SLIDELIB reads a list of slide file names from
standard input. This Is normally supplied by redirecting a list of files (one per line in another file
prepared using a text editor or a user-supplied utility program) to standard input. The resulting
composite library is written to the file specified by •library', with file type • .sib•. The files named in
•slide-lisr need not have file types specified. However, if a file type is specified it must be • .sld•.

For example, in AGVS EWS we've created a file named •slides. 1st• listing slide names •ccwise",
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•clockwise•, •exit•. •cancel•, ...• and -wsstor-. we could assemble slides Into a slide library named
•slides.slb• by entering:
C:\SEMATECH > \acad\slidelib slides <sltdes 1st
or

C:\SEMATECH > \acad\slidelib slides.slb <slides.lst

The SLIDELIB program makes no provision for updating a slide library once it is created.
If we wish to add or delete a slide, just update the •slide-list' file and remake the library with
SLIDELIB. Note that all the original slides must be present in order to do this.

A.1.3. Blocks with Attributes

A Block is a set of entities grouped together into a compound object. Once so grouped,
the entities are given a Block Name. You can use this name to insert that group of entities into
your drawing wherever you like. A block is treated as a single object by AutoCAD. For example,
in EWS we define as blocks the objects including (curved) segments, turntables, turnouts,
transfers, and stockers.
_ Attributes are special AutoCAD drawing entities that contain text. You can use them to
label Blocks in the drawing, then later collect them into a disk file for processing by the other
applications. In EWS, each block Is associated with several attributes. For example, the
stocker-block has four attributes including: (Q stocker ID; (iQ transfer ID; (iiQ stocker type; and (iv)
transfer type.
To use an Attribute, you must first create an Attribute Definition using the ATTDEF
command. An Attribute Definition Is an AutoCAD drawing entity that describes the characteristics
of the Attribute. It is displayed on the screen as a text string, called the Attribute tag. After you
create the Attribute Definition, you can specify it as one of the entities to be included jn a Block
DefinHion. Thereafter, whenever you INSERT the Block, AutoCAD can prompt you for the value
of the attribute, which may be any text string. Thus, each occurrence of the Block can have a
different value for the Attribute. The Attribute value Is displayed in the position previously
occupied by the Attribute tag. You can extract Attribute information from the drawing with the
Drawing EdHors ATTEXT command. This command writes the Attribute information to a disk file
in a form suitable for processing by user-supplied programs or for transfer to a database package
such as dBASE IV.
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Attributes can also be invisible. An invisible Attribute is not displayed or plotted;
however' infonnation about It Is stored in the drawing file and

wrmJn to the extract file by

ATTEXT.
Example: Module Symbol Creation
To maintain a separate layer for the insertion of module symbols the creation process
can follow the following steps:
(1) Open a new AutoCAD drawing file.
(2) Create a symbol to be the defining block on LAYER 0.
(3) Attach the appropriate attributes using the ATTDEF command.
(4) Define the symbol with its associated attributed as a block using BLOCK command. The
block name must match the one specified in the menu definition file.
(5) Store the block just defined as an AutoCAD drawing file using WBLOCK command. The file
name must match the one specified in the menu definition file.
(6) Copy the final drawing file into the EWS working directory.

OOI.E: The Convert program need to be modified accordingly whenever new blocks are created
or blocks' names are changed.
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A.2. AutoCAD Extemal Commands

In order to run another program from within AutoCAD, you must first inform AutoCAD of
the name of the program, how much system memory (RAM) it requires, and various other details.
You must supply this information in the •program parameters• file, •acad.pgp•; this file must be
present when you begin executing AutoCAD.
•acad.pgp• is an ASCII text file wherein each line describes a program (or batch file) that
can be executed from within AutoCAD. You can consider this to be a list of custom AutoCAD
commands; any time you enter a command, AutoCAD looks for !' in •acad.pgp• if it isn't a normal
AutoCAD command.
Each line in •acad.pgp• has five fields, delimited by commas. The fields are:
(1) Command name: The AutoCAD external command to be added. Must not be an internal
AutoCAD command or it will be ignored. This name is case-insensitive.
(2) File Command: This constant string will be sent to the operating system for execution when
the command name is entered. It may be any valid command which you might execute
_when at your operating system's command prompt.
(3) Memory reserve: On MS-DOS/PC-DOS systems, AutoCAD normally reserves all of the
computer's memory (RAM) for itself. Before a program may be executed, AutoCAD must
release sufficient memory to load the program. This required parameter specifies the
number of bytes AutoCAD must release before executing the command. The number
must be at least 4K larger than your program itself, to leave room for some data DOS
needs in order to run your program. The minimum reserve is about 24K bytes, however.
If the specified amount is less than this, AutoCAD forces it to 24K.
(4) prompt: This field, if supplied, specifies a prompt to be displayed to the user. If no prompt is
specified, on input will be requested. If no prompt is desired and fields follow, just use
two commas for the prompt field.
(5) Return cocte: This is an optional bit-coded Integer parameter. Its bits are defined as follows:
(i)

1 -Load DXB file

(ii)

2 - Construct block from DXB file

(iii)

4- Restore texVgraphics mode.

For more details, refer to AutoCAD Reference Manual. The •acad.pgp• of the EWS is shown in
Appendix B.
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APPENDIX B

ACAD.PGP File
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CLS,CLS,100000,,4
CONVERT,\SEMATECH\EXE\CONVERT,275000,,0
DISP,\SEMATECH\EXE\DISP,460000,,0
DXF1,\SEMATECH\EXE\DXF1,140000,,0
FMTRX,\SEMATECH\EXE\FMTRX,300000,,4
FRAME,\SEMATECH\EXE\FRAME,300000,,4
HEURlP,\SEMATECH\EXE\HEURl /N /P,400000,,4
MINISET,\SEMATECH\EXE\MINISET,lSOOOO,,O
MOD,\SEMATECH\EXE\MOD,250000,,0
MODULE,\SEMATECH\EXE\MODULE,250000, ,4
PE,PE TECH.MNU,l50000,,4
PROF1,\SEMATECH\EXE\PROF1,200000,,4
RCV,\SEMATECH\EXE\RCV,200000,,0
SEGMLIST,\SEMATECH\EXE\SEGLST,200000,,4
SHEET,\SEMATECH\EXE\SHEET,250000,,0
SHELL,,400000,*DOS Command: ,0
SIMUCPT,\SEMATECH\EXE\SIMUCPT,lSOOOO,,O
UPDATE,\SEMATECH\EXE\UPDATE,300000,,0
VEHICLES,\SEMATECH\EXE\VEHICLES,400000,,4
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APPENDIX C

Brief Description of the EWS Flies and Programs
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The files copied Into working directory and subdirectory EXE are required as support for
the EWS. The following are the descriptions of selected EWS-speciflc files:
C.1. Flies In working directory
ACAD.LSP - file contains user defined subroutines which can be called from within AutoCADTiot in
the same manner as are internal AutoLISP function.•. External subroutines are defined
using the AutoLISP command, •defun•. For more Information, see AutoLISP
Programme,.• Reference Guide.
ACAD.PGP - is the file which specifies the external commands called from within AutoCADnt.
These external commands can be either DOS commands, batch files, or executable
programs. The format of the ACAD.PGP file is described in Appendix of the AutoCADTIII
Reference Manual.
TECH.MNU - file contains the customized menu structure definition for the EWS.
CURVE1.DWG, CURVE2.DWG, STRAIGHT.DWG, TF1.DWG, TK1.DWG, TK2.DWG,
T01.DWG, T02.DWG, TT1.DWG, TT2.DWG, and TV1.DWG - are drawing files which
hold block definitions for elements such as curved or straight segments, horizontal
transfers, stockers, turnouts, turntables, and vertical transfers respectively.
EFLAG, FLAG and FLAG$$$$ - are intermediate flag files which facilitate communication
between external programs and the AutoCAOnt environment.
BASE. TXT- is a template file which specifies the information that will be extracted from ·the
drawing file for conversion to the network representation. See the related command
ATTEXT and the format of this file in Section 9.2. 7. 1 of the AutoCAI)lll Reference
Manual.
PROTOTYP.DWG- is the template (default) drawing file which contains the default drawing
parameters and references to default block definitions.
QUIT.SCR - is a script file which is automatically run when a session ends. The user is returned
to DOS without having to stop at the AutoCADnt main menu. The primary reason for
bypassing the main menu is to Insure consistency between the drawing and project files.

52

SLI DES.LST - a file which contains a list of slide file names used to make slide library.
SLIDES.SLB - is a slide library containing the slides used for the EWS's icon menus.
START.BAT - is the batch file which perfonns several functions at the beginning of each session
in the EWS. By defaun, START.BAT file comes initially configured for a single-screen
system. For the dual-screen system, edit this file by removing •REM ... • from the
beginning of all commands. This file also displays an MHRC logo, configures
AutoCAD'""'s memory environment, prompts the user for the project which will be used
during the editing session, activates AutoCAD"' in dual S(\ een mode (when configured
for dual-screen mode), and calls up the drawing file specified in the project profile.
C.2. Files In subdirectory EXE
CONVERT.EXE- program converts the geometric data extracted from the drawing file into its
network representation. The output from this program consists of the segment data, the
control point data, and the module data.
CBM.EXE- program sums the failure rate of several internal segments associated the modules
to find the critical ones. These critical (i.e. high expe<..1ed number of failures) modules
are stored in an ASCII file named •TECH.CMP•, and will be highlighted on the screen.
DISP .EXE - program generates graphic display of the system reliability measures for the user to
quickly locate the •hot-spot• modules.
DXF1.EXE - program reads the DXF file generated from DXFOUT command of AutoCAD, and
then output ·the file, SIMUCPT.DXF, with the control point ID's added.
FMTRX.EXE - program allows the user to specify the flow requirements between stockers. This
program can also be called from DOS by typing

C:\SEMATECH >\SEMATECH\EXE\FMTRX
to display or update the flow information. Here we assume the working directory is
SEMATECH.
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FRAME.EXE - program performs the reliability assessment of the system.

HEUR1.EXE - program is the implementation o~ the preliminary ·flow path design algorithm by
Bakkalbasi and McGinnis. The modeling assumptions are discussed In Chapter 1 of the
EWS User's Manual.

MINISET.EXE - program simply copies file FLAG to FLAG$$$$. It is used to facilitate
communication between the AutoCADTM environment and the external programs.

MINPATH.EXE- program finds the shortest path between every pair of control points in the
guidepath network, and computes the minimum travel distance between each pair of
stockers. The shortest path matrix is stored in compact form as a . PTH file.

MOD.EXE- program takes the TXT and MIF file as input, then makes the changes to the TXT
file necessary for representing all modules

informatio~.

MODULE.EXE - a utility program to access the module type information for the current session.
It allows the user to scan, list, sort or print the module type information.

MSG.EXE- program simply displays the copyright information.

PROF1.EXE - program maintains the project profile for an EWS session. When called in
START. BAT, it prompts the user for the active projEd name and sets the environment for
the current session. This program can also be called from DOS by typing

C:\SEMATECH >\SEMATECH\EXE\PROFl
to display or update the project profile.

RCA.EXE - program translates the critical segments found in the CSG file intc> the original (i.e.
before modification) control points and their coordinates for subsequent AutoCAD
display.

RESET.EXE- program simply copies the character$ into file FLAG$$$$. It is used to reset the
intermediate flag file.
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SEGLST.EXE - Is a utility program to access the segment Information for the current session.
The program will allow the user to scan, list, sort or print the segment Information.
SHEET.EXE- program provide the user with a friendly way of entering module type date
including IDs, MTBF, operation time etc .• and remarks.
SIMUCPT.EXE- program copy a control-point-10-added DXF file, SIMUCPT.DXF, to a DXF file
which has the same name as currently-edited drawing file, and the eXienslon DXF.
TITLE.EXE- program displays MHRC logo.
UPDATE.BAT- a batch file which updates the gaomeiry-related information first, then computes
the shortest paths.
VEHICLES.EXE- program allows the user to specify the vehicle type specifications. This
_program can also be called from DOS by typing

C:\SEMATECH >\SEMATECH\EXE\VEHICLES
to display or update the vehicle specifications.
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